





























Chanrt, just released and cov-
ered in depth in this issue.
While writing my review, |
found the program so compel-
ling that I used it to create the
charts that illustrate some
points in my article on working
with a single-drive Mac. The
idea for those charts arose di-
rectly from access to the tool
used to make them.

As the editorial department
has assumed greater responsi-
bility for graphics, the art de-
partment has become more in-
volved with the computer. Our
art director, Bruce Charonnat,
now uses the Mac as his pri-
mary graphics tool, and you

“an see the results on virtually
every page.

After only two issues, Mdc-
world is integrating text and
graphics in a way that has not
occurred in a magazine before.
I'm not referring just to integra-
tion on the printed page, but to
integration of our editorial and
production processes. For ex-
ample, we editors used to sub-
mit the copy for cover type to
the art department as a printed
list. Now we can use MacPaint
to create a dummy of the entire
cover. We play with type pos-
sibilities right on the dummy
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and produce instant cover com-
posites for final review by the
publisher, editor, designer, and
newsstand sales director. This
practice not only facilitates tai-
loring the type to the cover's
graphic design—it has resulted
in closer working relationships
among the various depart-
ments of our magazine.

In the premier issue of
Macworld, 1 predicted that the
Macintosh would change the
way we think about written
communication. We're witness-
ing that change firsthand. Mac-
world has become “The Macin-
tosh Magazine” in process as
well as subject matter. And
we've just begun. O
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side your copy of PC World are
lusting to know what it was that
stole my heart that day. Well, I
won't be coy. It wasn't the
mouse.

It was the coolness. During
the past two years, I have spent
a lot of time in front of green,
amber, and color monitors.
They make me hot. I'm not talk-
ing about excitement or eye-
strain. I'm talking about a
whole-body sensation, the kind
you get from sitting in a Fourth-
of-July weekend traffic jam in a
convertible with black uphol-
stery. That’s what those bright
little characters against dark
backgrounds do to me after a
couple of hours.

After the first half hour with
the Mac, I thought something
was wrong. Somewhere around
the 90-minute mark, 1 realized
that what was wrong was that
nothing was wrong. No heat ris-
ing behind my eves, no tight
back muscles, no fantasies of
Finnish ice baths distracting
me. [ was cool. An hour and a
half in front of a computer
monitor, and 1 was still fresh,
excited, and ready for more.
That light gray screen with its
crisp black text is worth three
color monitors.

Flashdancing with the Mac
Someone had actually taken
the time to think about what
might make a human being feel
good while working with a per-
sonal computer. That someone
had also put a lot of thought
into making me a potential
buyer. So far, all I had done was
try my hand at writing a report
with MacWrite. That's right,
with an electronic easel and a
brand-new mouse at my finger-
tips, I had gone straight to
work. A dyed-in-the-wool work-
aholic, I figured I might as well
get a report or two out of the
way while familiarizing myself
with yet another word pro-
cessor. Having reviewed ten
IBM PC word processors over
the past year, each one accom-
panied by more over-hyped
promotional literature than a
John Travolta movie, the last
thing I expected to get a thrill
out of was the Mac's writing
tool.

Forgive my jaded ignorance.
Writing with the Mac is not
word processing at all. It’s
“flashdancing” for writers. Your
words are fully alive on the
screen the way they are in a
well-designed magazine. And
it's more than being able to see
margins, indents, line spacing,
underlining, and boldfacing the
way they appear on paper. You
realize that you are the archi-
tect and interior designer of
every page of text, arranging
and rearranging the shape, the
style, and the placement of your
words, and even fusing them
with pictures until they convey
the exact meaning and emo-
tional tone you intend.

Fake Right, Go Left

If 1 always knew ahead of time
where my writing was going, |
probably wouldn't use a per-
sonal computer at all. I'd dictate
my articles while driving to the
health club and save my fingers
for caressing my wife and hug-
ging my kids. My style, how-
ever, is to write five words and
then change seven, as Dorothy
Parker described writing.

How a word processor de-
letes is as fundamental to me as
how it lets you enter text. You
can judge the personality of a
computer writing system by
how it removes what you no
longer want. Some restrict you
to picking lint off a blue
blazer—Iletters have to be
erased one by one with the de-
lete or destructive backspace
key, because the only other op-
tion is to kill whole lines at a
time. This is usually impracti-
cal, since many lines contain
text from the end of one sen-
tence and the beginning of an-
other. With other systems, your
only alternative to nitpicking is
to clean away large mistakes
like a sentence or a paragraph
and then reenter a whole new
one, when all you want to do is
quickly replace a descriptive
phrase or a subordinate clause
with a tighter, more clever ex-
pression that just popped into
vour head. MacWrite gives you
unlimited control over the de-
letion process.
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Note Pad

To Change or Not to Change
Another example of the Mac’s
impact on your writing attitude
is the way it handles a typical
writer's constant indecision
about whether to delete some-
thing in the first place. Many
professional writers and writing
professionals are not sure
whether they like the new
phrase better than the old one
until they see it in context.
With many word processors,
however, once you see the new
words, the old ones are gone
forever. Some PC word pro-
cessors have an “Oops” key,
which lets you restore the text
vou have just deleted, but they
often have an additional rule
that you may not press any keys
between deleting characters
from the screen and pressing
the “Oops” key. This kind of
svstem does not allow you to
be so cavalier about making
changes. MacWrite avoids
these inhibiting “no backs™ lim-
itations with an unusually ver-
satile Undo command com-
bined with equally versatile cut

and paste functions. You can re-
store a recent cut, take back an
insertion in midstream, or even
Undo your last Undo.

Gallery One

My artist wife has been toying
with the idea of expanding
from pen-and-ink sketches to
computer-generated art for a
year, but shopping for the right
combination of drawing device,
software, and printer for our PC
has proven to be quite a job. If
we'd had a Mac and MacPaint
for two years instead of a PC,

by now she'd have produced
enough art to have opened Jill's
Black-and-White Gallery, and
the Mac comes with everything
we'd need to team up for a re-
naissance in illuminated man-
uscripts. It would be ironic if
we started writing parts of our
IBM PC software newsletter on
a Mac just to liven it up with
creative fonts and illustrations.

Not All Fun and Games

The Mac is a lot more fun than
my businesslike PC. It is not
priced like a toy, however. It
costs more than $3500 with a
printer and a second disk drive,
and when Apple offers up-
grades to 256K RAM chips
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(which would add greatly to
the system’s flexibility) and
800K disk drives, we will be
talking about a $5000 invest-
ment. The only toy I would
spend four or five grand on,
however, is a car—maybe a
well-kept old Alfa.

When [ raised that issue with
a local Mac salesperson, she
quickly produced the Mac ver-
sion of Multiplan, Microsoft's
popular electronic spread-
sheet. Nothing makes a per-
sonal computer look less like a
toy and more like a business
tool than a spreadsheet.

Spreadsheets, however, are
my least favorite type of soft-
ware. They conjure up images
of Bob Cratchit slaving away
late into Christmas Eve, balanc-
ing Scrooge’s accounting
ledgers. They intimidate me,
partly because I generally pre-
fer playing with big words
rather than big numbers, but
also because whenever I have
tried one on my PC, I have al-
ways come away feeling that I
missed something.

Mudltiplan a la Mac is the
spreadsheet I have come clos-
est to genuinely understanding.
The pull-down menus, the
mouse-selected cells, and the
dialog boxes that “talk” to me
when I am in trouble—all

these features unique to Mac
spreadsheeting changed my
image of this category of soft-
ware from intimidator to
helper.

Love and Money
I am the kind of person who
thinks about buying a new car
as soon as the payments are
made in full on the last one.
Owning an IBM PC did not pre-
clude my ogling the hundreds
of new systems released during
the past two vears. Becoming a
two- or even three-computer
family is right up my inflation-
ary alley, but aside from the Ra-
dio Shack Model 100, there
hasn't been anything different
enough from my PC to tempt
me to add another monthly
pavment to my list of debts.
Meeting the Mac did not
make me want to trade in my
PC. In fact, I'd like to upgrade it
to an XT to make it even more
businesslike. It will, however,
remain on my work desk in a
quiet corner of the house. The
Mac will probably sit in the liv-
ing room where everyone can
fall in love with it. O
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Letters

Programmer’s Praise

I want to congratulate you on
your new magazine. Macworld
has an attractive layout; I espe-
cially like its wide format and
larger-than-usual type. It's nice
to see a computer magazine
that has such a generous ratio
of editorial content to ads, but
maybe you're not as pleased as
[ am with that.

As a would-be software de-
veloper, 1 enjoyed reading
about Apple’s efforts to attract
developers. It's a welcome idea
to provide a user interface—in
ROM no less. Your report on
the desktop environment made
me want to run out and try it
[“A Tour of the Mac Desktop”].

A standard user interface will
make a big difference in writing
programs, but as your writer
admits [Lon Poole, “The 64K
Treasure Chest”], one really
needs a Lisa too 1o create a
large software program be-
cause the Macintosh has no
programming languages of its
own vet. Any idea when they’ll
start showing up?

Barry Rapf

Baltimore, Maryland

For a look at one new pro-
gramming language for the
Mac, see “MacPascal Preview”
in this issue. Future issues of
Macworld will report in depth
about programming on the
Mac and the Lisa 2s—FEd.

Multiplan Warning
There appears to be a serious
bug in version 1.00 of Micro-
soft's Multiplan. Don't use the
“shortcut™ method to save your
document: if you choose Quit
from the File menu and rely on
the alert box to ask to save
changes, your worksheet will
be permanently garbled.
Danny Goodman
Pacifica, California

We contacted Microsoft and
they confirmed this bug. The
company has released a new
version (1.01) of the program,
in which the bug has been
[fixed. Purchasers of version
1.00 who returned their regis-
tration cards should have
been notified by Microsoft
about the procedure for up-
dating to version 1.01. If
you're still using version 1.00,
you can avoid corrupting
your worksheets when saving
them by following these steps:

® Make sure the Clipboard
is empty by selecting an inser-
tion point and choosing the
Cut command.

® Sauve the worksheet using
the Save or Save As command
Jfrom the File menu.

® Do not save the worksheet
by using the Quit, New, or
Open command.—Fd.

Hacker’s Lament
Apple sure has its nerve! What
are they trying to do here? |
have spent vears becoming a
Lord High Hacker. I tweaked
the front panel switches,
learned the mysteries of PIP,
format/s/8, init hello,s6,d2,
Debug or DDT for WordStar
patches, and the assembly of
many strange numbers. My
friends and neighbors looked
upon me with awe. I almost
learned octal, of all things.
And now people are doing
useful work with this Mac after
only a few minutes, with abso-
lutely no training. I think this
computer stinks. By the way,
please enter my subscription.
James F. Shobert
Commack, New York

A Dearth of Software
I am using my Macintosh in my
daily work as a technical writer
and sincerely regret the imme-
diate lack of software. 1 still
have to use my old TRS-80
Model 100. I hope the software
becomes available soon. Other-
wise, I am sure this lack will
have an impact on Macintosh
sales in the future when the
bloom is gone.

Fred Wilkinson

Santa Clara, California

More than 100 software com-
panies received Mcacs from
Apple before release, and maj-
or companies currently work-
ing on software for the Mac
include Microsoft, Lotus
Development, Software Pub-
lishing, Continental Software,
Ashton-Tate, and Sorcim.
More software will be appear-
ing during the next few
months.—Ed.

A Mac Drawback

I had never used a computer
(never needed or wanted to)
before I recently tried out a
friend’s brand-new Macintosh.
He had been telling me how
“friendly” the machine was
supposed to be, but he is fond
of computers anyway. Only
when I turned the pages of the
first issue of Macworld did 1
start getting interested.
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The “impressions of a
novice” [in Note Pad] appealed
to me, and Jeffrey Young is
right—the Mac's desktop does
arrange things the way we “pre-
computer” types do.

I'm a writer and have almost
finished a rough draft of a book
on American history. After fa-
miliarizing myself with the
Mac, I put my prospectus into a
file. Revising it—moving the
insertion point with the mouse
and erasing typos with the
Backspace key—was a snap,
since [ didn’t have to type and
retype or use that messy cor-
rection fluid. And by mixing
fonts and styles, I created a very
artistic format.

The major drawback for my
purpose is the lack of storage
on the Mac’s single-sided disks.
Although I can split the work
up by chapters (or smaller
files), it would be nice to carry
the whole book around on one
little disk.

Still, I'm sold on the Mac as a
personal word processor. And I
can’t wait to find a way to sneak
MacPaint into my work.

Glen Epstein

lTowa City, lowa

See “The Compleat Disk Jug-
gler” in this issue for some so-
lutions to your problem.—Ed.

Mac CAD

My primary interest in any com-
puter is its use in CAD (com-
puter-aided design). I have
some questions regarding the
use of peripherals such as digi-
tizer boards and plotters.

At the present time, the Ap-
ple I and III series has avail-
able any number of those units.
However, they are not totally
menu-driven; all drawing
must be originated using X-Y
coordinates.

The discussion of the Mac's
graphics ["MacPaint: the Elec-
tronic Easel”] seems to indicate
infinite possibilities with pre-
sent software; however, there
was no indication that the
screen image could be trans-
ferred to a specific scale (e.g.,
imperial architectural, imperial
engineering, or metric) to pro-
duce “scaled” printouts or
plots.

In addition to the graphics
available, a CAD program
would also require a menu for
windows, walls, toilets, ap-
pliances, etc. Can those sym-
bols be created or are software
companies anticipating them in
the near future?

Combined with the mouse, a
digitizer board, and a plotter,
the system could provide a
powerful tool at a minimal
cost.

E. "Manny” Abraben

Fort Lauderdale, Florida
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Apple’s forthcoming MacDraw
(second quarter 1984) will
enable you to draw the archi-
tectural symbols you mention
and will provide on-screen
rulers that can be set to spec-
ified scales. We know of no
other architectural or en-
gineering programs under
development at this time, but
watch Macware News for pre-
views of Meac software and
peripherals.—Ed.

User Groups
I realize that the Macintosh is
hot off the assembly line, but
I'd like to know if there are any
user groups in my area. I found
your premier issue interesting
and informative, but [ want to
have more direct contact with
my fellow Mac users. Do you
have any information on this?
Susan McPhee
Chicago, Illinois

10 assist individuals in locat-
ing Macintosh clubs, the Inter-
national Apple Core will send
current listings for clubs that
bave formed or are being

Jformed. To obtain informa-

tion on clubs in your area, or
information on setting up a
Macintosh club, send a self-
addressed, stamped envelope
to Macintosh, International
Apple Core, 908 George St.,
Santa Clara, CA 95050,
408/727-7652. Macworld will
report on user group ac-
tivities in future issues. We
encourage user groups to
submit copies of their news-
letters, article suggestions,
bands-on tips, and draw-
ings.—Ed.

Letters should be mailed to
Letters, Macworld, 555 De
Haro St., San Francisco, CA
94107, or sent electronically
to CompuServe 74055,415 or
Source STE9O0S8. O






























[4 Getting Started

NENEEENEEES
The immediate solu-
tion for creating more
disk space is to pro-
duce separate work-
disks for MacWrite and
MacPaint.

The Scrapbook File contains about 8K. If you like
the images there, keep them. Otherwise, you can clear
a little more disk space by cutting the images vou don't
want. You can do this by choosing the Scrapbook from
the Apple menu, scrolling through the Scrapbook
screens, and choosing Cut from the Edit menu to re-
move unwanted images from the Scrapbook.

Following the steps above will free up 71K on the
disk. (You can see the results posted below the title bar
by emptying the Trash.)

Font Mover

You can clear even more space, and that's where
Font Mover comes in. (The Font Mover utility was
added to the Mac software after the first printing of the
owner's manual. Future printings of the manual will
document this feature.) You can see from Figure 3 that
the Macintosh fonts take up a good deal of space on
the disk. For most writing applications, you won't need
all those fonts. Font Mover provides you with a way to
remove them from the System file.

Select the Font Mover icon, and open that applica-
tion either by double-clicking on the icon or by choos-
ing Open from the File menu. You'll see a screen simi-
lar to the one in Figure 6. By clicking on the names of
the various fonts, you can see a sample of each font and
how many bytes it occupies on the disk. You can also
select more than one font by dragging or by holding
down the Shift key and selecting additional fonts.
(Clicking on the button labeled “Help” in the dialog
box gives you a clear explanation of how to usc Font
Mover.)

Font Mover offers two options. You can remove a
font from the System file entirely (similar to disposing
of it in the Trash), or vou can extract the font from Sys-

Write/Paint Disk

Imagewriter-17K
Scropbook=7K
Chpboard- I¥
Natepad-2¥
Macwrite-53)
MazPaint -60%
M Forttover 134
M Sorple Memo -3
3 ovadabie-43k

Figure 2

This chart shows how the Write/Paint disk storage is allocated
You'll have enough room for only a short paper and a few
sketches. However, you can optimize your disk spcace by creat-
ing separate Write and Paint disks and by taking advantage of
the Font Mover wtility.
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tem and copy it to a separate file called Fonts, which
you can then move to another disk for storage. Since
the disk you're creating will be a working disk and you
already have a backup copy of the original Write/Paint
disk, there's really no reason to copy any of the fonts.

However, vou're better off using Copy instead of
the Remove option. If vou mistakenly remove a font,
Font Mover gives you no way to restore it, and it will be
deleted when you Quit the application. It's safer to
copy the fonts to the separate Fonts file and dispose of
that file later.

How do you decide which fonts, if any, you want
to remove? That depends on the sort of writing you
normally do. For general text, Geneva, New York, and
Toronto are the three fonts that work best, usually in 9
or 12 point, but two are probably sufficient. You can
keep just the Geneva and New York series and dispose
of all the Toronto fonts. The rest of the fonts are better
suited for headings and titles, though Chicago-12 is
also a readable font.

If you like to printin high resolution, you'll also
want the 18- and 24-point versions of your text font.
That’s because high-resolution printing uses the point
size at twice the size vou see on the screen and com-

l *Geneva-9
Geneva-12
Geneve-14
Geneva-18
Gerevo-24
New York-9
Il *lew York-12
B New Vork-14
¥4 New York-1g
5 New York-24
J Torento-9
Toronto-12
Toronto-14
¥ Toronto-18
Teronto-24
*Chicoga-12
*Honace-9
B Monaco-12
Venice-14
(] Athens-18
[H London-1€
Il San Fron-18
Y desh gccess

Figure 3

Alarge part of the System file—about S6K—is taken up by the
22 subfiles that contain the information needed to display
and print the different fonts. The Desk Accessories take up the
remainder of the System file—about 57K.
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TEEEEEENENGER
Because the Finder
can transfer only part
of a disk at a time,
swapping is a fact of
life with a one-drive
Mac.

presses it to produce higher quality printed leters. If
vou want to print New York-12 in high resolution, for
example, vou'll need New York-24 on your disk.

Finally, the Finder requires that certain fonts al-
witys be available to it for creating the various menus,
dialog boxes, and labels; Geneva-9, Monaco-9, New™
York-12, and Chicago-12 are preceded by an asterisk to
signify that you cannot remove them.

A rational choice might be to eliminate San Fran-
cisco, London, Athens, and Venice because they're dec-
orative fonts not likely to be used in regular writing ap-
plications. Monaco-12 is very similar to Geneva-12 and
therefore dispensable unless you have special need for
a monofont (in which all the letters occupy the same
amount of space).

Choosing which fonts (if any) to remove is, of
course, up to you, but by removing all of the above-
named fonts and quitting the Font Mover application,
vou can reduce the size of the System file by about
40K. Since you have several backups of the original
Write/Paint disk, you can drag the newly created Fonts
file into the Trash. And because you are also finished
with the Font Mover utility, vou might as well drag that
into the Trash and save another 13K.

These deletions free an impressive net amount of
124K of additional space, for a total of 174K of storage
for your letters and memos. Compare the chart shown

in Figure 7 with the one in Figure 1.

% File Edit lView Special
Write/Paint
5 items 348K in disk 52K available

|

Completely replace contents of "ACF Data
17 tnot in any drive) with contents of

[
“Write/Paint” (internal drivel?
[ ok Cancel |

Figure 4

When you drag a disk icon onto the icon of another disk,
the Mac gives you this dialog box. This message gives you a
chance to change your mind before you replace the contents
of the destination disk

Paint Workdisk

You can make similar savings on your Paint Work-
disk, although you'll probably want to retain a more
complete selection of fonts. Keep in mind, however,
that you're not prohibiting voursell from ever using the
fonts you discard from that disk. They will still be
available to you on the W/P Workdisk; vou'll just need
to copy them to the specified disk. What you're doing
is optimizing a working disk for the type of work you'll
be doing most often.

When removing files from vour Paint Workdisk,
vou'll save a bit of disk swapping by ejecting the cur-
rent disk in the machine and restarting the Mac using
the Paint Workdisk.

On the subject of reducing the size of the System
file, one can’t help noticing that the desk accessories
also take up valuable space. Most of us probably do not
need the Puzzle or the Control Panel on every disk.
Perhaps someday we'll be provided with a full-fea-
tured resource mover utility that lets us add or remove
desk accessories at will.

Using the Workdisks

Now that you have created working versions of
MacWrite and MacPaint that each have expanded stor-
age capacity, how do you put them to use? Here are a
few guidelines that can help your work proceed
smoothly.

The most efficient way to use the Write and Paint
workdisks is to store all your text or picture files on
them. You'll be able to edit or print a file directly with-
out having to do any disk swapping.

" & File Edit Diew Special ?

Files remaining to copy

"y
[EIE)  Please insert the disk:
<.

Write/Paint

Figure 5

The Finder keeps you informed of the number of files remain-
ing to be copied and provides prompts for inserting the differ-
ent disks during swapping maneuvers. The number of swaps
necessary to copy a file depends on the size of the particular

Sile.
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[d Getting Started

S EEREEEEEEN
The Cut and Paste
commands in the Edit
menu enable you to
combine text and
grapbics from separate
MacWrite and MacPaint
workdisks.

that you rename the disk to indicate that it's now a data
disk. (Again, make sure that each disk has a distinctive
name.)

Because vou'll be using data disks to store files
that vou create, you can take advantage of the full 400K
capacity of the disk. You do, however, have to run your
applications from vour workdisks. The following is a
sample procedure using MacWrite:

1) Insert the Write Workdisk and open MacWrite.

2) If you are creating a new document, just start
typing.

3) If you want to edit an existing document,
choose Close from the File menu and then immedi-
ately choose Open from the File menu. Now click the
Eject button and insert one of vour data disks. You'll
see a list of all the MacWrite files on that disk. Click on
the name of the file you want to edit, and click the
Open button. MacWrite will read that file into mem-
ory and then prompt you to reinsert the Write
Workdisk.

4) When vou're finished working on that docu-
ment, choose Save from the File menu. You'll be
prompted to switch disks again while the Finder saves
vour edited file to vour data disk.

A Combination Storage System

If you intend to produce several documents, you
might find it more convenient to create and save each
one on your Write Workdisk and then transfer those
files to a data disk for permanent storage. This pro-
cedure is also convenient for making backup copies of
files. A sample procedure is as follows:

1) Use MacWrite to create several documents and
save them on the Write Workdisk.

2) Quit MacWrite to return to the desktop.

3) Eject the Write Workdisk and insert a data disk.

4) Select the files you want to transfer from the
Write Workdisk window. You can select several files at
once by dragging a rectangle around all of them or by
holding down the Shift key and clicking on each one.

Font Mover

Help

>»Topip?

it )

Name: San Francisco
Point size: |8
Disk Space: 2984 bytes

* reserved for system use

in Fonts file
San Francisco- 18 [

in System file
New York- 9
*New York-12
New York-14

New York-18
New York-24

Toronto- 9

Bample

Figure 6
The Font Mover utility lets you free wp space on your disks by

removing fonts you don't use fron the System file. You can ei-
ther delete a font completely or copy it to a separate tonts file,
which you can subsequently move 1o another disk jor storage.
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5) Drag one of the selected icons from the Write
Workdisk window onto the icon for the data disk. (1f
vou've selected more than one file, vou'll see an out-
line of all the selected icons fly across the screen as if
in formation.)

6) Follow the prompts for switching disks until all
the files have been copied.

7) To free up space on vour Write Workdisk, select
the transferred files and drag them into the Trash.

The Finder has eccentricities that you may want to
keep in mind. You have to eject the workdisk in step 3
before you can select the files in step 4. The Eject com-
mand works on what is selected, and you can't eject a
selected file.

You must reselect the files vou copied to remove
them to the Trash. Although it would be a bit more
convenient (and equally logical) if the Finder kept the
original files selected, it just doesn’t work that way.

If you drag one or more files into the Trash and
then eject the disk, the files in the Trash will be auto-
matically removed, without warning, even though you
never emptied the Trash.

There’s no question that if you need to manage a
large amount of data, purchasing an additional disk
drive would be an investment that would quickly pay
for itself in time savings and convenience. But if vou
are on a budget or want the convenience of an easily
transportable computer, a Macintosh with one internal
drive can serve you well. By experimenting with varia-
tions on the above storage plans, you should be able 10
devise your own work routines that will maximize
your disk storage capacity, minimize disk swapping,
and make your one-drive Mac a more productive
tool. O

Write WorkDisk

W Fnder-46x
W System-107x
B imogewriter-17x
Clipboard - 1K
B Notepod-2¢
MocWrite-53K
avotioble -1 74K

Figure 7

You can increase the space available on your Write workdisk
by more than 120K by eliminating the MacPaint application,
the Scrapbook file, Sample Memo, and unnecessary fonts.
Compare this chart with the one in Figure 2.
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& File Edit View Special

Class Notes

18 items 394K in disk

46K available
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Rhysic 19th Century European fo
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Sth Century European Novel 4/ Jews and Moslems in Christian Spe Expenses

A
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rite Di T
Paleontology 4/9 ickens Term Paper

Expository ¥riting Seminar 4/10 Religions 4/11

el 4/10 ame Bovar

AN

Palanntology 4/11

[[J[==— Expository Writing Assignments

Size HName Kind

Last Modified

12K Muclear Disarma... Mac\Write document
14K Social Effects of...Mac\rite document

Sun, Apr 8, 1984
Sun, Apr 8, 1984

Figure 1

Joe is a freshman in college, and be uses bis Mac
Jor all bis schoolwork. Unfortunately, his Mac
desktop looks like his dormitory room. It is clut-
tered because bis files are placed randomly on
the desktop and the names are too long. The doc-

& File Edit Diew Special

Class Notes

uments listed by name in the window named
“Expository Writing Assignments” are abbrevi-
ated by the Finder because they are longer than
the space allotted for file or folder names.

18 items 354K in disk

46K available

MacWrite Paleo Expository ' Social

@ O

Fon Expository Wril Physical ¢ Nuclear Disarmam Critique of Madam Paleontology 4/11

ntury 19th Century European Nov Jews and Moslems in ChriEmpty Folder System Folder

Figure 2

Choosing the Clean Up command from the Spe-
cial menu arranges the icons in orderly rows
and columns, but because the names of Joe’s files
and folders are more than about 12 characters
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in length, they overlap on a crowded desktop.
He'll have to drag some of the icons to an open
space to figure out what they are called.

Labeling Your Disks

One of the most basic and important
techniques for keeping track of files is la-
beling micro-floppy disks clearly with the
files or type of files they contain. Other-
wise, you'll be starting up disks and check-
ing their contents unnecessarily. Give your
work disks and data disks concise names to
indicate their contents (the more specific
the better), and give each disk a different
name to eliminate confusion during multi-
ple-disk work sessions.

File Catalog

You might find that you don’t have
enough room on your disk label to write all
the information vou need to give an accu-
rate and useful account of its contents. This
problem can be overcome by printing pa-
per copies of your disk or folder directo-
ries. First, arrange vour files or folders by
name, date, size, or kind on the desktop.
Each of these View options displays the
same information in different ways. A fully
expanded directory window can display in-
formation on up to 17 files, including size
(amount of K), name (in boldface type for
easy reference), kind (file types such as
folder, application, or MacPaint docu-
ment), and the last date each file was modi-
fied. Arranging directories By Name will
provide an alphabetical listing of the con-
tents (see Figure 4).

To get a printout of the entire screen
(which includes the name of the folder or
disk in the title bar), engage Caps Lock,
hold down the 8 and Shift keys, and press
4. If you have more than 17 files stored on a
disk or within a folder, simply scroll a new
set of files into the window and repeat the
procedure for printing the contents of the
window. This technique is especially useful
for detailing the contents of backup disks
and data disks that contain numerous files.

Get Info

Make use of the Get Info command in
the File menu. When you select a disk icon,
file, or folder and choose the Get Info com-
mand, a window will appear containing
information about the selected object, in-
cluding kind, size, name, and location of
the disk the file is on, the date the file was
created, and the date of its last modifica-
tion (see Figure 5).

If you select several objects on the
desktop simultaneously (choosing Select
All from the Edit menu selects every file on
the desktop) and choose the Get Info com-
mand, Get Info windows will zoom out



one on top of another on the desktop (see
Figure 6). Clicking on the title bar or any
exposed area of a window makes it the
active window. This feature gives you in-
formation about your files quickly and effi-
ciently, and demonstrates some of the vi-
sual flash of the Finder. You can have up to
seven Get Info windows displayed on the
desktop at once.

The Locked box indicates whether a
disk is write-protected. The term write-
protect means that the contents of a disk
are frozen—you can't alter the documents
in your files or folders. If vou slide the red
tab on the corner of a disk toward the
edge, start up the disk, and choose Get
Info, the Locked box will have an X in it,
indicating that the disk is locked (write-
protected). Some applications, such as
MacPaint, do not work if the disk is
locked, while others, including MacWrite,
allow you to open a file even though vou
can't make any changes. The owner’s man-
ual notes that changes made on the desk-
top are not saved and that desk accessories
may not work properly if your startup disk
is locked.

The Locked feature also functions at
another level. You can protect files, folders,
or application programs when a disk is
not locked. When you click on the empty
Locked box in a Get Info window pertain-
ing to objects on the desktop other than
disk icons, an X will appear. This tells the
Finder that the particular object cannot be
disposed of in the Trash and that its name
can’t be changed; however, you can move,
modity, or duplicate it. This option is es-
pecially useful if the kids decide to play
with your machine and drag all your files in
the Trash.

Each Get Info window has a box at the
bottom for user comments. Using it is one
of the best ways to identify the contents of
a file or a disk—what vou can't relate in a
short title can be conveyed in the user
comment box. It also enables you to keep
this layer of information off the desktop
unless you need it. If you forget what a file
contains, you won't have to go into the par-
ticular application to look at the file. You'll
quickly learn to take advantage of this fea-
ture when you accumulate numerous files
and need more specific details about a file
or a folder. You can type about three lines
of text (about 30 words) in the comment
box, and you can edit the text using the
standard Macintosh techniques.
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Class Notes

18 items

354K in disk

46K available
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Figure 3

Here are Joe's files and folders renamed and ar-

ranged on the desktop. He has learned how to

optimize the space available on the desktop for

O

& File Edit DlDiew Special

Last Modified

Sun, Apr 8, 1984
Tue, Jan 24,1984
Tue, Apr 10, 1984
Thu, Apr 12, 1984
Sun, Apr 8, 1924
Sun, Apr 8, 1984
Tue, Apr 10, 1984
Sun, Apr 1, 1984
Sun, Apr 8, 1984
Tue, Jan 24, 1984
Sun, Apr 1, 1984
wed, Apr 11, 1984
Mon, Apr 9, 1984
Ved, Apr 11, 1984
Mon, Apr 9, 1984
VWed, Apr 11, 1984
Mon, Apr 9, 1984

Size HName Kind
8K  Dickens Macrite document
0K Empty Folder folder
7K EuroMov4/10 Mac¥write docurnent
7K EuroNov4/12 Mac'w'rite docurnent
3K  Expenses Mac'w'rite docurnent
26K  Expos folder
2K ExposSem4/10 Machrite document
13K Font Mover application
16K Jews/Moslems Mac'write document
53K Mac¥rite application
9K  MBovary Machw'rite document
6K  Paleod4 /11 Macyrite document
7K Paleo4 /9 MacWwrite document
9K  PhAnth4/11 Machrite document
1K PhAnth4/79 Mac¥rite document
9K  Relig4/11 MacWrite document
ISK Relig4 /9 MacWrite document
Figure 4

> Class Notes

l

Trash

displaying icons. Each file bas a distinctive, con-
cise name so that Joe can see at a glance what
each file contains.

Arranging icons By Name gives you an alpha-
betical directory of your files, and the name of
each file is in boldface for easy reference. Yout
cannot move files by View menit arrangements

other than By Icon, but you can open, duplicate,
or rename them. You can also get a printout of
the entire screen so that you have an informative
disk directory on paper.
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& File Edit VDiew Special

Information about Class Notes

Class Notes
disk

46440 bytes available, 353944 bytes used
Where: internal drive

Created: Sunday, April 1,1984 at 1:58 PM

Modified: Sunday, April 12, 1984 at 3:06 PM

OJtaskes

Herein lay notes for the week April 9-13, expository
writing papers for the spring quarter, EuroNovel stuff,
and my exorbitant expenses for the monthj I

Kind:
Size:

Figure 5

The Get Info command in the File menu is one of
the most useful features of the Finder. Every ob-
Ject on the desktop bas a Get Info window that

contains information about the selected object,
and a user comment box allows you to incliude
information that won't fit in a brief name.

% File Edit lView Special
Class Notes

g jtems 354K in disk 4 ilable
Information about Paleo4/9 |=ﬁ,}
Information about Relig4/9 |

Information about Paleo4/11
Information about Relig4/11

E— Information about PhAnth4/9

PhAnth4/9

Kind: MaclWrite document

Size: 981 bytes, accounts for 1K on disk
Where: Class Notes, internal drive
Created: Monday, April 9, 1984 at 2:04 PM

Modified: Monday, April 9, 1984 at 8:47 PM
[ Locked

Boring, boring, boring...notes are a bit incomplete. |
— | [fell asleep during the lecture]

Figure 6

When you select several objects on the desktop at
once and choose the Get Info command, Get Info
windows zoom out on the desktop, one after

another, demonstrating the visueal flash of the
Finder: Joe is checking to see if bis class notes are
worth reading.
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Folders

As a general rule, you should organize
your files logically and hierarchically using
the iconographic folders provided by the
Finder. Because the Mac desktop mimics
the way you use ordinary files and folders,
you should easily adapt to working on the
Mac desktop. When you accumulate a
group of interrelated files, drag them into a
folder and give the folder a concise name
that reflects its contents. For example, vou
could place files containing your class
notes for particular courses or monthly
business expense reports in folders.

(To create folders, select the Empty
Folder and choose Duplicate from the File
menu. This procedure places a copy of the
Empty Folder on the desktop. Then give
the second folder a new name and place
vour files in it. Because the Empty Folder is
a permanent fixture on the Mac desktop,
you can create new folders as you need
them.)

You might want to display your files
within folders as text (by name, date, size,
or kind) rather than as icons. These ar-
rangements provide you with more infor-
mation than an icon can and, as a directory
of information, are easier to read. A direc-
tory of files listed alphabetically (By Name)
is a more practical arrangement than a
group of icons randomly placed on the
desktop. Although you can't move files dis-
played as text, you can open them by
choosing Open from the File menu or by
double-clicking on an entry in the window.
You can also duplicate or rename them. On
the other hand, you can display up to 32
icons in a fully expanded window, as com-
pared to up to 17 items by the other View
options. Of course, vou can always scroll
the contents of any window to display more
files.

You can also place folders within
folders. This type of lavered structure will
help keep your desktop from being clut-
tered with icons or lengthy directories (see
Figure 7). You can use the comment box in
the Get Info window to explain the hier-
archical structure of your folders. Because
your workdisks, such as MacWiite, have
limited disk space, you probably won't
need to create an elaborate file-handling
system involving lavers of folders within
folders unless your files are very small and
interrelated.



Three lavers of folders within folders
are probably adequate for managing large
quantities of interrelated files on data disks
that contain document files only. More than
three layers will necessitate an inordinate
amount of digging to access a file.

File Handling

Because the Mac's desktop is basically
an electronic filing cabinet, don't get in the
habit of leaving icons strewn across the
desktop as in Figure 1. The Clean Up com-
mand from the Special menu will rear-
range icons in orderly rows and columns,
but it is up to you to do the real cleaning
up. Otherwise, your Mac desktop will be
just as disorganized and cluttered as your
pre-electronic desktop.

If you have several short memos, lists,
or reports in separate files that can be con-
solidated, move them into a single file
whenever possible using the cut and paste
techniques common to all Macintosh ap-
plications. Be sure to dispose of the empty
files from which the contents have been
deleted.

Get into the habit of transferring files
to the appropriate disks or folders. Here's
an example of a typical situation in which
this strategy comes up. While you are work-
ing on a report in MacWrite, you get a
phone call from your boss giving you de-
tailed statistics pertaining to a report that
you have stored on another disk. You can
write the information either on the Note
Pad or in your current document. If you
leave the information where you originally
wrote it, you might forget about it or in-
clude it in the wrong report. Instead, cut it
from its original location and paste it into a
new MacWrite file. Then save it with the
name Stats adding some special characters
(such as >>>)at the end as a visual cue
to remind you that this file needs to be
properly stored. Return to your current
project by closing the newly created file
and opening the file that contains your cur-
rent report.

When you get back to the desktop, the
file labeled Stats>> > will be displayed.
The >>> at the end of the file name
should alert you to move that file to the ap-
propriate off-line disk. Be sure to dispose
of the copy on the original disk to save disk
space unless you need it for backup pur-
poses. “The Compleat Disk Juggler” in this
issue offers techniques and advice on mov-
ing files to off-line data disks with a single-
drive system.

. . . . ]
& File Edit View Special
Class Notes
10 items 354K in disk 46K available
O O
MacWrite EurolNov Expos Paleo
EuroNov
Q 3 items 31K in folder 46K available
Font Mowver
li’ EuroNow4 /12 EuroNov4 /10 EuroMov Papers
Systern Folder] =] EuroNov Papers
2 items 17K in folder 46K availg

Figure 7

Joe finally discovered how to keep his desktop
neat and orderly. He created a folder for each
class be attends and placed the files with bis class
notes within the appropriate folders, such as
EuroNov (European Novel). Another folder

within the EuroNov folder contains papers re-
cently written for the course. This hierarchical
structure is essential for maintaining an effi-
cient work environment.

r

& File Edit Uiew Special
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354K in disk
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7 items 327K in disk 73
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MacW'rite
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Figure 8

Having just your working files, folders, and ap-
plication programs visible in a window will help
economize space on the desktop, allowing you to
display more information at once on the screen.

Joe was getting ready to cut and paste some
drawings created in MacPaint into bis paleontol-
ogy class notes, but he needed a short diversion.
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Guided Tour Detour

Q. The first thing I did when
[ took my Macintosh home was
start up the Write/Paint disk and
try MacPaint. After I finished
using my Write/Paint disk I de-
cided to take a look at the
Guided Tour. When T inserted
the Guided Tour disk, T got a
message: “Repairing this disk.
All folders were lost; their con-
tents have moved back o the
disk window:" I clicked OK;
then itasked me w insert the
Write/Paint disk. followed by
the Guided Tour disk. Why did
this happen?

L. R.Pitkin

Boulder, Colorcado

A. Though you didn't say so,
you must have ejected the
Write/Paint disk by choosing
Eject in the File menu (or by
typing 8 ), then inserted the
Guided Tour disk. If vou had
switched vour Mac off and on
before inserting the Guided
Tour disk, the “Repairing this
disk...” message would not

have appeared. By clicking OK,
vou may have ruined vour
Guided Tour disk. Had you
switched off your Mac when
that message appeared, vour
Guided Tour disk would still be
intact.

The fault here lies not with
the Mac, MacPaint, or the
Guided Tour. You are a victim of
Finder incompatibility. It seems
that some copies of the Guided
Tour disk were inadvertently
fabricated with an early version
of the Finder, and vou got one
of those. To be sife, you should
always restart the Mac (power
off, then on) before inserting
the Guided Tour disk and after
ejecting it.

The disk you use when you
switch on the Mac becomes the
startup disk, and its Finder
reigns supreme. Even if you
¢ject the startup disk and insert
another, the Mac continues to
use the Finder from the startup
disk. You used a Write/Paint
disk to start up the Mac. [ts
Finder could make no sense of
the Guided Tour disk. which
was created using an carlier
version of the Finder.

The “Repairing this disk...”
message can occur for other
reasons too. For example, if the
disk is spinning and the power

goes off, the disk contents can
become scrambled. The next
time you insert that disk, the
Finder will recognize the disar-
ray and offer to repair it. You
may click OK to proceed with
the repairs or switch off the
Mac and try restarting. The disk
may work the next time vou in-
sertit. If the "Repairing..."
MEssage appears agadin, you
will have 1o click OK and let the
Finder repair the disk.

MacBASIC

« [ read somewhere that
BASIC on the Mac will let me
run more than one program at
a time and that it doesn't use
line numbers. But a dealer told
me that it is comparible with
IBM BASIC. How can that be?
Walter A. Nevins
Charleston, South Carolina

A. You read about one ver-
sion of BASIC and heard about
another. Your dealer was reler-
ring 1o Microsoft BASIC, be-
cause it is available. It is com-
patible with other versions of
BASIC, including I1BM BASIC.
(Look for a review of Microsolt
BASIC in an upcoming issue of
Macworld.)

Apple has its own dialect of
BASIC under development, one
that attempts to combine the
best features of Pascal with the

familiarity of BASIC. This inter-
preted BASIC is being designed
especially for the Mac and
should be available sometime
this summer. It will be a while
before we'll see a complete re-
view on Apple’s Macintosh
BASIC, but I arranged for a
sneak preview:

Every time you run a Mac-
BASIC program, a new output
window appears. You can have
any number of output windows
stacked up; moving newer ones
aside reveals older ones be-
neath. Clicking on the close
box closes and removes an out-
put window: You can also have
more than one program listing
window present on the screen.
MacBASIC listing windows are
independent. Lach window can
contain a different program,
and all the programs can he
run simultaneously: (Of course,
the profusion of windows can
become confusing if many pro-
grams are runninf_’, atonce.)
The number or the size of pro-
grams running at once is lim-
ited, however, because the pro-
grams must share the Mac's
available memorv.

In keeping with the Mac's
uniform working environment,
the techniques for editing Mac-
BASIC programs are similar to
those for editing MacWrite
documents. You can cut and
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Get Info

paste, copy and paste, insert,
and delete any part of a pro-
gram, ranging from one line to
a whole program. The Undo
command gives you the option
of changing your mind about
your previous editing or typing
action. In addition to the usual
find and replace capabilities,
you will be able to search for a
match to whatever is in the
Clipboard or is currently se-
lected on the screen.

In a radical departure from
standard BASIC, MacBASIC will
not require line numbers. You
may use a mnemonic label, a
line number, or nothing at all at
the beginning of each program
line.

Nonstandard MacBASIC
statements offer flexible condi-
tional execution, new loop
structures, extensive screen
formatting, and four-voice
sound. Other statements let
vou draw lines, rectangles,
ovals, and even pictures made
up of those shapes. Limited
control of windows, menus, di-
alog boxes, buttons, and dials is
also available.

MacBASIC is a hybrid lan-
guage made up of ideas taken
from several other languages
and grafted onto a BASIC stalk.

Its enhancements and unusual
features make programming
easier, but they wreak havoc
with compatibility. Programs
written in other BASIC dialects
may run under MacBASIC with
only a few changes, but the re-
verse is unlikely.

Imagewriter or Nothing

o [ already own an Epson
MX-80 printer. Can I use it with
the Mac instead of Apple’s
Imagewriter?

William R. Sterling
Decatwr; Georgia

A. Some people already own
printers that they understand-
ably want to use with their
Macs. Others, who think that
today’s dot matrix printers print
no better than those of a dec-
ade ago, dogmatically refuse to
accept anything but daisy
wheel output. Today, you have
two choices when it comes to
printing a Mac document: use
an Imagewriter or don’t print.
The folks at Apple are pres-
ently studying the best way to
accommodate other printers.
Their first priority was to de-
velop a low-cost printer that
could print anything displaved
on the screen, and the Im-
agewriter fills that need. Even-
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tually, about 80 percent of the
printers on the market should
work on the Mac to some de-
gree. The Mac will probably be
able to utilize the full capabili-
ties of only a few. Some will be
able to print only text, while
others will be able to approxi-
mate pictures with millions of
overlapping periods, like the
Apple Daisy Wheel printer does
with Lisa documents. But don't
expect any daisy wheel to repro-
duce displayed Mac images
as well as the Imagewriter can.
You might think that another
dot matrix printer will work,
since many of them can print
graphics and fancy type fonts
as well as the Imagewriter can.
Forget it. The Mac uses a pro-
gram called a printer driver to
send information to the Im-
agewriter in a form it can inter-
pret. Every other brand of
printer requires the same infor-
mation but in different formats,
so none will work with the
standard Mac printer driver.
Perhaps some programmer will
develop an alternate printer
driver for another brand of dot
matrix printer. Are there any
volunteers?

Even if dot matrix printing
bothers you categorically, don't
dismiss the Imagewriter until
you've seen what it can do with
a good ribbon on high-rag-con-
tent paper in high-resolution
mode. After all, the screen im-
age is made up of dots, and
most modern typesetting
equipment COmposes type
from lots of tiny dots. (The type
in this magazine is set that
way.) It’s all a matter of dot size,
and the Imagewriter actually
prints twice as many dots per
inch as the Mac screen displays.

m The disk is full. Try another disk.

MacPaint Disk Full
Messages

Q « When I open a MacPaint
document just to look at it, with
no intention of changing even
one dot, I get a disk full mes-
sage. 1 know that my disk has
20K or 30K available. What's
going on?

Ruth Feldman

Hollywood, Florida



A. MacPaint needs lots of
elbow room on the disk. Be-
cause pictures can get very
large—occupving more than
SO0K in extreme cases—aMac-
Paint makes no attempt to keep
one picture entirely in the
Mac's memory. At any time, the
only part in memory is the part
currently visible within the
document window. When vou
use the grabber tool or the
Show Page command to move ¢
different part of the document
under the window, MacPaint
copies the new part into mem-
ory from the disk. It also copies
onto the disk the part that has
gone out of view. Your changes
will still be there when you
move the edited part back into
view,

MacPaint does not copy di-
rectly to and from vour docu-
ment, however. If it did, vou
could never use the Revert
command from the File menu
to start over again with the last
saved version, because that ver-
sion would be corrupted with
your changes. MacPaint uses
copies of your document,
which it stores in a scratchpad
on the disk.

To provide this scratchpad on
the disk, MacPaint sccretly
opens two extra documents,
named Paintl and Paint2, right
after it opens vour document.
It copies vour whole document
to Paint2 immediately. Paintl
stays blank for the time being,
The first time you move the pic-
ture under the document win-
dow, MacPeaint copics the
whole document 1o Paintl, in-
cluding any changes vou may
have just made.

From Paint2, MacPaint cop-
ies into memory the newly visi-
ble part of the picture, and
displays it in the document
window. Paintl will contain the
most recent version and Paint2
the next most recent version.
As vou move the picture
around under the document
window, MacPaint continues to
keep the two most recent ver-
sions of your picture in Paintl
and Paint2. If anvthing happens
to the scratchpad document,
MacPaint can revert to the
other. When you quit Meic-
Paint, it automatically removes
Paintl and Paint2 from the disk.

Your MacPeaint disk needs
enough space available for both
scratchpad documents. Paint2
always occupies at least as
much disk space as the original
document. Paintl initially oc-
cupies 2K, but it expands to
match Paint2 as soon as vou
move the picture around under
the document window. As a

rule of thumb, figure on need-
ing free space on your Mac-
Paint disk at least twice the size
of vour original document.

MacPaint's use of scratchpad
documents also prevents vou
from using it on a locked
(write-protected ) disk. It tries
to create Paintl and Paint2, but
the lock stymies it.

Accidentally Deleting
Documents

Q- A couple of times [ have
accidentally dragged the wrong
icon into the trash and clicked
Empty Trash on the Special
menu. Sometimes the Mac
throws up a dialog box, and |
have to click OK before I can
delete a file, but not always. [s
there anything I can do to keep
from accidentally losing my
work?

George Mizuno

New Bedford, Massachusetts

A. The Mac asks you to con-
firm icon removal when the
icon represents an application
or system document. It pro-
vides no automatic safeguard
for vour own documents. How-
ever, you can protect valuable
documents by locking them. To
lock a document, select its icon
and choose the Get Info com-
mand in the File menu. Doing
that will open an information
window for the document.
Each Get Info window has a
check box labeled “Locked.” To
lock the document, click on
that check box. When vou do, a
cross will appear in the check
box to signify a locked docu-
ment. If you try to remove a
locked document, the Mac will
report, “That item is locked or
in use and can’t be removed.”
To unlock a document, click
again on the Locked box in its
information window.

Send your questions to Get
Info, Macworld, 555 De Haro
St., San Francisco,
CA94107. 0O
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How to save the Lisa from an ignominious end?
Apple’s answer: make the Lisa and the Mac allies, not
enemies. Promote their many similarities and mini-
mize their differences. Eliminate the major disparity—
the disk drives—Dby substituting a Macintosh-style
drive for the Lisa’s twin nonstandard drives. Give the
Lisa the ability to run Mac software. At the same time,
retool the Lisa’s software to run two or three times
faster. And instead of insisting that people buy a main-
deck Lisa or none at all, let them choose from among a
lower deck, a main deck, or a promenade deck. Fur-
thermore, let them start with a lower-deck Lisa and
move up later.

The result of this detente between the Lisa and
the Mac is the four-member Apple 32 SuperMicro fam-
ily (see “Macintosh and Lisa 2 Specifications”). All four
models feature a very high resolution black-and-white
screen, a mouse, a single 3%-inch microdisk drive, the

+4+4+4+ 4 complete Mac

screen image fits
on the Lisa screen with
room to spare.

same arrangement of keys on the keyboard, and the
MC68000 16/32-bit microprocessor. At $2495, the Mac
has the lowest price; its small size and light weight
make it fully transportable. The Lisa models range in
price from $3495 to $5495. They are more than twice
the size and weight of the Mac, have larger screens (12
inches vs. 9 inches, diagonally) and more memory
(512K vs. 192K), and can be expanded with additional
memory and hard disk drives. (In the near future, a
hard disk and other peripherals will be available as
Mac add-ons.) All the new Lisa models can run Mac
software.

The Lisa 2 ($3495) is essentially a bigger, more
powerful, expandable Mac. Its larger memory (512K)
accommodates larger spreadsheets and word process-
ing documents, and its larger screen lets vou see more
of those documents at once. Its expandability enables
it to grow along with your needs.

The Lisa 2/5 ($4495) adds a 5-megabvte external
hard disk to the Lisa 2, making it most like the original
Lisa. It can run many applications created by indepen-
dent developers for UNIX-like operating systems. By
adding more memory, you can use the Lisa Office Sys-
tem, with its simultaneous operation of multiple Lisa
applications in the Lisa Desktop Environment.

The Lisa 2/10 ($5495) gives you everything the 2/5
has and twice as much hard disk space, built into the
cabinet rather than housed externally.

Lisa-Mac

To use Mac software such as MacPaint, MacWrite,
or Multiplan on the Lisa, you must first start the Mac
desktop environment. Right now, that procedure is ac-
complished by inserting a special disk labeled “Mac-
Works” (Apple may change that name) and switching
on the Lisa. If your Lisa 2 has a hard disk, you must lis-
ten carefully for a click from the speaker, then simul-
taneously press the Apple key (same as the Mac  #
key) and the 2 key. Pressing those two keys tells the
Lisa to start from the microdisk, not the hard disk. Al-
though Mac software can presently support only 3-
inch micro-floppy disks, plans are underway to give it
access to the hard disk by summer.

The Lisa goes through several seconds of self-tests
and then begins to copy information from the Mac-
Works disk into memory. Since it hasn't the 64K ROM
of the Mac, it must copy the equivalent of that ROM
from disk into its regular memory each time vou start
it. The MacWorks disk comes with the Lisa 2 but costs
$195 extra with the Lisa 2/5 and 2/10.

After about 5 seconds, the Lisa ejects the Mac-
Works disk and displays the same disk icon with a
flashing question mark that yvou usually see when vou
first switch on a Mac without a disk inserted. From this
point on, everything works the same as if you were
using a Mac. Insert a Mac system disk or some other
start-up disk.

Soon the Mac desktop appears on the Lisa screen.
You notice a difference immediately. The disk and trash
icons are nearer the center of the screen than the right
edge, and everything looks lanky, like a wide-screen
movie shown through a conventional lens (see
Figure 1).

A Big Desktop

A complete Mac screen image fits on the Lisa
screen with room to spare. There are 22 extra dots at
the bottom of the screen (about 0.4 inch) and 208 ex-
tra dots at the right of the screen (about 2.3 inches).
This space is available for larger windows, more icons,
wider word processing lines, more spreadsheet col-
umns, and so on. However, not all application pro-
grams are designed to take advantage of the extra
screen space. Some, like MacPaint, have fixed-dimen-
sion windows, and others, like early versions of Mu/ti-
plan, do not allow enlarging the window past the di-
mensions of the Mac screen. Microsoft Chart has been
written so that it can take advantage of the Lisa’s larger
screen. The program detects whether it is being run
on a Lisa and adjusts its display accordingly (including
scaling the screen aspect ratio).
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the manuals should be as attractive as the
product itself, so much so that they com-
pete with the product for attention, you
can develop a useful manual.

Macworld: The most obvious differ-
ence between the Mac user manuals and
traditional manuals is that they are com-
pact and short. Was writing those man-
uals more difficuilt than writing longer,
more traditional ones?

Seropian: Writing short documents is
very difficult. Who was the writer who
said, “If you want a short document you
have to give me a week, but I'll write a ten-
page document in one night™?

Espinosa: The easiest way to keep
documentation short is to have the pro-
gram do the right thing in the first place
and do something useful. Several times
when Bill Atkinson, who wrote MacPaint,
was reading Carol Kaehler’s documenta-
tion, he saw that certain things were diffi-
cult to explain. That's a sure sign for the
programmer that the program needs work.

Kaehler: Whenever Bill read a draft of
something I wrote, if there were more than
a certain number of words, he would
change the program code because that
meant that the procedure was too
complicated.

Johnson: The Mac programmers were
as interested as we were in creating easy-
to-use programs. But we had a different
perspective. They had been in this indus-
try a long time, and their programming pri-
orities tended to get in the way at times. We
would go back and say, “From a user’s point
of view, this isn't a convenient way to do
this, even though it makes good, tight
code.” They were very receptive. The inter-

relationship between the writing process
and programming is nowhere near what it
could be in this business.

Macworld: How did you decide on
what to call various commands and
other features that make up the Mac
desktop environment and application
programs?

Johnson: Coming up with the terms
was really an organic process. We would
just start using a word, such as Organizer
for the Finder. But when we used Orga-
nizer, people felt uncomfortable with it.
They would say that it’s a plastic thing that
you put on your desk, or that it sounds sort
of political.

Kaehler: We had a little motto that if
we had to talk about something more than
once, we needed a name for it. Some
people believed that the Finder was not
going to have a name. We would just talk
about what it does. I remember sitting and
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mation from more detailed support infor-
mation. Chris had made it clear that he
wanted both tutorial and reference sec-
tions as well as some kind of bridge be-
tween the two. The second chapter of the
manuals—the “using” sections, which we
call the cookbook—is that bridge. It's a
new design in computer manuals.

In an application manual such as Mac-
Write, the reference section provides an
understanding of every command and
what it does—the supporting information
about how the program works—whereas
the cookbook section was designed to
deal with procedure. If you want to know
how to set up a format and have it look
right, vou can go to the reference section
and read about rulers and formatting or
you can go to a recipe that tells you how to
set up a format for existing text. Step-by-
step instructions are not new in education,
but they are fairly new to computer
manuals.

Seropian: What's unique is that we
thought of the user and how he or she
would want to access information. In the
old days, vou had to go to page 85 to look
something up, go back to reference 42 on
another page, and then pull it together
vourself. You don't have to do that with the
cookbook; all the commonly asked ques-
tions are answered.

Macworld: How is the cookbook dif-

Sferent from the tutorial?

Kaehler: An important difference is
that the cookbook is generic, whereas the
tutorial section that precedes it uses a spe-
cific example that you build on. Because
the cookbook is generic, it allows you to
apply general rules to what you are work-
ing on, separate from what you learn in the
tutorial.

Espinosa: The tutorial gets you start-
ed, gets you over your fears, and intro-
duces you to the fundamental concepts and
methods used to run the program. The ref-
erence section tells you in very terse but
accurate detail what each tool is, what each
command does, and what the fundamental
structures and concepts of the program
are. That's how most manuals are set up.

What falls through the cracks is the
group of users who go through the tu-
torial—they are not novices anymore, but
are barely intermediate. Most of the skiers 1
know got over being novices very quickly
and became intermediate skiers, but they
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will remain intermediate skiers all their
lives. That's how most computer users are.
They will never be able to jump into a ref-
erence manual, look at an abstract defini-
tion of a command and its function, and
understand how they can use it in interest-
ing ways. You still have to know a lot about
computers to do that.

The most powerful thing that comput-
ers do is enable you to combine tools in in-
teresting ways to do the things you want to
do. That’s what the cookbook sections are
for. They take the tasks you most often
want to accomplish and show you step by
step what commands and functions to use.
The cookbook sections finish off the learn-
ing that the tutorials start. We want to in-
still in the user an imagination for combin-
ing those tools and to introduce more
facets of each tool. That's what the cook-
books do. They give you instant gratifica-
tion. They do what you want them to do,
and then they show you a little more.

After using the cookbook several
times, the user sees many tools that he or
she didn’t know how to use before, and
sees them in new and interesting ways. [t
shows the user the principal advantage ol
computers: that you have a huge toolbox of
things you can combine to do interesting
things that wouldn’t be possible if you
knew only what they did individually.

Kaehler: The cookbook fills in the
gaps where the software design isn't intui-
tive. You have to pick and choose certain
elements that vou can get separately from
the reference and tutorial sections. It puts
together those procedures in an inventive
way.

Johnson: If everything were really in-
tuitive, you would need only reference ma-
terials. Copying a disk is not intuitive. You
can get that information in the Reference
section if you feel like reading, or you can
go through the sequential steps in boldface
at the top of the page in the cookbook sec-
tions [ “Using the Finder,” “Using Mac-
Write,” and “Using MacPaint™].

Macworld: How did you target the
level of the cookbook section?

Seropian: We've shown this machine
to many people. The question theyv ask
most is, “Now that I've done this, how do |
do such and such?” You have to tell people
how to do the next thing. We often don't
know all the possibilities. I wish it were
possible to know all the how-to questions.
The difficulty is to come up with just the
right questions.

Espinosa: We can never answer every-
body’s how-to questions, because there is
an infinite number. What we want to hit are
the most common ones that people will
ask in the first month or two of using the
machine, and we want to answer those
questions so well that people will be happy
with the book and will go back to it. The
biggest problem with writing a manual is
getting people to trust it and use it. We
tried, in writing the cookbooks, to avoid
giving too much information about what a
tool is or what it does, or confusing read-
ers with superfluous facts. We wanted to
help readers solve specific problems so
they can go back to what they are really
concentrating on—their work.

Macworld: Obriously, MacPaint is the
most original manual of the three. It's
like a 32-page cookbook that gives you
the fundamental ingredients and vari-
ous techniquees, but no specific recipes.
How did that particidar manual evolre?

Kaehler: I first wrote a traditional
manual on MeacPairt. When my mother
was visiting, she was going to test the man-
ual. She sat down and within about three
minutes stopped reading. 1 said, “Mother,
you have to read this” She'd read another
few paragraphs or a couple more pages,
and then she'd be off playing with Mec-
Paint again. It was depressing to have your
own mother not be able to go through your
book.

Bill Atkinson read it and said, “T really
want you do to something outrageous to
this. This just isn't right.” It was difficult at
first, because we thought we had the guide-
lines for writing down. We thought we
were going to be able to do every Mac
manual in a consistent way. Chris said, “Pre-
tend you don't have any of these directions,
pretend you are just going to do something
without any guidance from anyone.” For
about three or four weeks I didn’t write any
words. I had a boot screen 1 created that
said, “T will think in arrows” All I did for a
few weeks was arrows,

Macworld: Wheat do you mecan by
‘arrows”? l .

Kaehler: Ways to describe motion. We
feel comfortable using words, but words
were so unwieldy in describing what was
happening with MacPaint. The structured

examples just weren't fun. No one wanted












‘ Review

the X column of the window, representing category
number 1, and the numbers vou enter appear in the Y
column, representing the value for that category (see
Figure 1). This combination makes the first data point
in a new data series.

As you enter more numbers, you create additional
data points in the series (see Figure 2). On your first
exposure to the program, all this activity may seem a
bit abstract and disorienting, as well as having little to
do with charts. To see the connection, click the box
marked Plot Series, then click in the untitled chart win-
dow. The untitled window will spring to life with a
trimly formatted column chart of the data just entered
(see Figure 3).

Picture Perfect

Someday, reviewers may become so accustomed
to the quality of the Mac screen that they will no
longer feel the need to string superlatives when de-
scribing it. During these early Mac days, however, we
must mention the exceptional resolution with which
Chart’s graphics are presented. The edges of the
shapes are razor sharp, and the type is almost letter
quality. The Mac’s charts might even be of higher qual-
ity than those in your morning paper.

Data Formats

Your chart may look great, but so far it lacks a key
to what the data represents. For example, suppose the
data values represent miles run during seven days of a
training program, To make the data (and the chart)
more intelligible, first make the series window active
again (by clicking anvwhere on it), then pull down the
Data menu from the top of the screen, and give the
data some attributes. If the data you enter represents
your daily running mileage, you will probably select
the Date option, since your categories are individual
dates (see Figure 4).

You will then be presented with a dialog box
showing the default values for the data series and the
category and value names (see Figure 5). To make the
data reflect the real-world model of running mileages,
complete the boxes as shown in Figure 6.

When you click the OK button in the dialog box,
two things happen. Your window for the data series is
updated so that the name for the series and the de-
scription of what the categories and values represent
are listed in the heading of the window. Simultan-
eously, the window displaying the chart is updated
with the series name and the category and value de-
scriptions (see Figure 7).
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Figure 1

The New Series window (with X and Y columns) appears when
you start Chart, and the program creates a window for a new
data series when you type any number.

" & File Edit Data Gallery Charl Format

Untitled

New Series
E[IE= Series 12:23:54 =
Order:
[IPlot Series
X v
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Figure 2
As you enter value (Y) numbers, Chart generates data points
in the series.

A Different Slice

One precept of running for conditioning is that
your greatest daily mileage should not go beyond one-
third of your week’s total mileage. The column chart in
Figure 7 doesn't give a clear indication of this factor. A
pic chart would reveal that information much more
clearly.

To change the form of the chart, pull down the
Gallery menu and select Pie. You will then see a dialog
box showing six optional forms of pie charts (see Fig-
ure 8). This is a perfect example of how the Mac inter-
face and Chart’s implementation of it excel. Instead of
wading through verbal descriptions of chart attributes,



vou see pictures of forms that convey a great deal of in-
formation without one word. One of the chart types
will already be suggested, shown as a highlighted im-
age. select the type of pie chart you want by clicking
on the appropriate image.

Option 6 in the pie chart gallery indicates relative
percentages of the pie segments. Choosing that option
and clicking OK displays the new chart shown in Fig-
ure 9. It's now clear that the training has stayed within
its guidelines.

Format

S Untitled ===

Series 12:23.54

Figure 3
Clicking in the Plot Series hox and thein clicking in the untitled
chart window generate a colunni chart of voin: data series.
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Figure 4

1o modify your series, first make the series window active by
clicking on it: then choose an option from the Datca nemi (in
this case, Dete).
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Category Name:

]
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( ok ] (‘cancel)

Figure 5
The Date Series dialog box allows you to format attributes for
the data series.
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Figure 6

Type the appropriate attributes in cach box, moving from one
box to another by pressiig the lab key: Also set the Increment
on Deays

More Data

Once the chart is configured, vou can easily add
more data to it. First, make the data window the active
window by clicking on it or by choosing List from the
Data menu. Then use the pointer and the scroll bar to
locate the last entry in the data series, and type in
more daily mileage numbers. Since the data format
has already been set 1o increment each category by
one day, vou simply type each new number and press
the Enter key; the successive dates appear automati-
cally. All the standard Mac editing conventions are
available when vou enter data, including cutting and
pasting, scrolling, and moving or changing the size of
the data window.
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Figure 7
Since the data and the chart window overlap, click on the
chart window to bring it to the front for viewing. The data
series attributes are now included in the chart.
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Figure 8

1o alter a chart format, pull down the Gallery menu and se-
lect a different kind of chart (in this case, Pie). Chart provides
seven types of charts that have several options each.

Since the Plot Series box in the data window has
already been checked, each new data entry causes the
chart to be redrawn in the chart window. Because this
process slows things down considerably, choose Man-
ual Redraw from the Chart menu (similar to manual re-
calculation on a spreadsheet). To view the chart with
the additional data, click within the chart window, and
the chart will be redrawn.

A pie chart having mileage figures for a whole
month is not very useful, so choose Column option 3
from the Gallery. The resulting chart with the addi-
tional data will appear as in Figure 10. (The title of the
series has been changed to "April Training™ and the
categories have been reformatted to show only the
day.)
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The Basics and Beyond

The foregoing information illustrates the basic
steps used in producing charts: creating a data series,
categorizing the data, and selecting the chart form.
Those three steps can be taken in any order; that is,
you can specify the nature of the data or the form of
the chart before you create or add to the data series.

New Chart users will have to get comfortable
with the meaning of a data series and its relation to a
visual chart. The data series concept is not used in

Figure 9
The column chart bas been reformatted into the selected
pie chart.
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Figure 10
The chart has been reformatted as a column chart with a new
title and additional data that covers the entire month.
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Figure 11

Assecond series and a legend bave been added to the chart
shown in Figure 10. The chart now shows monithly mileage for
two runners.
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Figure 12
A line graph showing the statistical trend of the daily runs in
miles has been adcded to the monthly figures in Figure 10.

word processing or spreadsheet programs. Once that
concept is absorbed, however, Chart makes creating
attractive and useful charts very easy—almost
automatic.

Many users will be satisfied with this simple, auto-
matic operation and will stick with it to produce per-
fectly functional data presentations. But Chart offers a
wealth of options and extensions—enough to keep an
avid chartist exploring the program’s potential for
months.

Multiple Data Series

The first logical extension of the basic chart is to
plot additional data series. By clicking the New Series
window (which is always present), you can start enter-
ing data into a second series. The data can be more of
the same type, such as mileages for another runner, or

of a completely different type, such as the minutes-per-
mile speed rate of each daily run.

Once you have made the New Series window
active, you can start entering new data. Unless you
choose to define new data attributes, the new series
will have the same attributes as the series previously
defined. This feature is convenient in that often the
second series will represent the same categories and/
or values as the first. Once a second series is entered
and its Plot Series box checked, the new series will be
plotted with the first series. Figure 11 shows monthly
mileages for two runners. Notice the legend indicating
which columns represent which runner. It was pro-
duced by choosing Add Legend from the Chart menu.

Figure 12 shows the monthly mileages for one
runner with a line graph showing the statistical trend
of daily runs in miles. This second series was pro-
duced automatically from the original series by choos-
ing Analyze from the Data menu and then clicking the
button marked “Trend.” The chart format was pro-
duced by selecting Combination from the Gallery
menu.

Massaging the Data

Other options available from the Analyze selec-
tion enable vou to create a new data series that repre-
sents the average, the cumulative sum, the differences,
and the relative percentages of the original series.
Other analysis options compute the statistical growth,
the median, and the standard deviation and correlation
coefficient of the original series. All these options can
be plotted as additional graphs along with the original
series. Another option lets you sort any data series by
category or value in ascending or descending order.

Chart has the capacity to plot up to 63 data points
per series and a total of about 120 data points among
all series, depending on the memory overhead re-
quired by the chart format. This exceeds what can usu-
ally be displayved meaningfully on the screen. It also
has significantly greater capacity than most microcom-
puter charting programs. (The memory limitations of
the program are discussed later in this article.)

Formatting the Data

Chart provides great flexibility in formatting darta.
By choosing Categories or Values from the Format
menu when a data series window is active, you can
have number categories and values shown in general,
dollar, percent, or decimal format. Date categories can
display year, quarter, month, date, or day in full or ab-
breviated form. The effects of these formatting con-
trols appear in the data window as well as in the labels
for the categories and the values in the chart window.
In addition, specified text can be appended before or
after the categories or the values, such as “Division 3"
or “DM 2000." This text appears on the chart but not in
the data window.

-
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Regardless of how many data series are plotted,
the chart labels are taken automatically from the title,
category, and value descriptions of the first series plot-
ted. Accordingly, if you plot more than one series, you
will probably have to change the chart title for the
chart to make sense. The controls for doing that are
described in the following section.

More Elaborate Charts

The other general way in which Chart lets you
enhance your charts is with an extensive array of
graphic formatting options. The easiest way to refor-
mat charts is through the formats offered in the Gal-
lery menus (see “'Canned’ Chart Formats”).

The Gallery formats are just the beginning.
Whenever the chart window is active, you can select
virtually any element of the chart—title, labels, axes,
legend, series or data point elements, even the plot
area and the whole chart—and specify their text posi-
tion, size, font and type style, pattern fill, line weight,
and graphic style from an amazingly wide range of op-
tions. You can also add text anywhere on the chart, as
well as arrows, lines, and borders in a variety of shapes
and styles. Some of the creative possibilities using ad-
vanced formatting techniques are illustrated in “Creat-
ing a Custom Chart Format™ and “The Compleat Disk
Juggler.” both in this issue.

In this area of chart formatting, Chart demon-
strates its power and versatility as well as the com-
plex routines that underlie the program. You could
spend months investigating the options that Chart
makes available by pulling down a menu and clicking
buttons.

Yet the program is not without limitations. One
usetul feature not included is the ability to transform a
data series into a smooth, variable curve (the Data
Trend and Growth selections produce only straight-
line analyses). Chart cannot produce bar and column
charts that have the appearance of being three-dimen-
sional, nor does it permit true three-dimensional
charts (ones that plot three variables).

Ease of Use

As long as vou stick with the preformatted chart
options, the program operates simply and performs
reliably. Once you venture into the unexplored terri-
tory of customizing your own formats, however, be
prepared to master a staggering array of commands
and possibilities. In this way, Chart demonstrates good
program design; it offers automatic operation for the
new user without sacrificing flexibility and versatility
for the expert.
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Before you get involved in customizing vour
charts, be sure that you understand the relation of the
Format menu choices to the Data and Chart menus.
The Data menu is the route 1o selecting the type of
data series and specifying some of the data param-
eters. The Format menu, on the other hand, provides
two choices labeled “Categories™ and “Values” that fur-
ther configure the format of the data series.

The Chart menu presents two selections labeled
“Main Chart Type” and “Overlay Chart Tevpe” that offer
manual selection of the tvpe of graphic presentation.
The Format menu takes these further with two selec-
tions labeled “Main Chart™ and “Overlay Chart.” Be-
cause all three menus control formats in various ways,
the distinction between what is covered in Data and
Chart and what is covered in Format is not always
apparent.

Another source of possible confusion is the fact
that the various Format selections are not available all
the time, and that the same command may operate on

===l Chart provides
great flexibility in for-
matting data.

different elements of the chart, depending on which
element is selected. You can eventually understand the
underlying logic of the various menus, but not without
some experimentation and a thorough reading of the
user manual. The documentation is well written and
well produced and provides a good reference to the
program, but don't read it casually.

Performance

The most notable limitation to Chart’s perfor-
mance is that it makes disk accesses whenever a chart
is redefined and redrawn. The cause of this lies more
with the Mac’s memory limitations than with faults in
the program; in fact, the Microsoft programmers are to
be commended for squeezing so much functionality
into the available memory capacity.

Justas everv reviewer can’t help but comment on
the Mac’s superior screen resolution, almost every re-
viewer (and programmer) will wish for more memory
in the machine until larger capacity memory chips be-
come a standard part of the Mac environment. Until
the blessed day when more memory arrives (hope-
fully sometime next vear), the greatest inconvenience
that Chart’s disk accesses will cause is in learning the
program. The faster a program responds to your com-
mands, the easier it is to learn by experimenting. De-
lays in response degrade the interactive quality that
generally makes a computer a powerful teaching tool.



Lack of memory also limits the amount of data
that can be computed and plotted. On a 128K Mac, a
maximum of about 12 series of 12 integer data points
each can be charted. That capacity will decrease if
complex graphic elements are added to the chart. Al-
though memory limitations are not usually a problem
in terms of chart capacity, you might have trouble if

7

you try to chart a complex application.

Rough Spots

This program does have a few annoying charac-
teristics. Repositioning or resizing text, the plot area,
or the entire chart can sometimes produce unpredict-
able results, and the fact that the program takes time to
redraw the whole chart with each intermediate adjust-
ment can make fine tuning somewhat teclious.

A number of shortcut 8 key options are provided
to select, show, and redraw the chart window. It would
be helpful if there were a 8 key alternative for the
Data List command, which is used frequently.

Another sticky point is the procedure for elimin-
ating a data series once it has been created. You must
select the entire series by dragging the pointer across
both headers in the data window and then cut the se-
lection. A dialog box asks whether you want to cut the
series along with all its points. The procedure isn't dif-
ficult, but it’s not obvious either.

Similarly, it is somewhat confusing to clear the
program. Selecting New from the File menu causes the
chart format to revert to the start-up default if the chart
window is active. If any data window is active, the New
command will erase all the data series in memory. (In
both cases, a warning asks whether you want to save
changes.) To start with a completely clean slate, how-
ever, you have to give the New command twice: once
for the chart and once for the data. A dialog box giv-
ing you the choice of clearing the chart, the data, or
both would be more straightforward.

Some of the more advanced techniques involve
choosing the right combination of options from vari-
ous menus. Two examples of such techniques are in-
serting value and key labels for data series and points,
and creating and scaling a separate value axis for the
second multiple data series (see “Tips for New Chart-
ists” for advice on adding these features).

As mentioned previously, not all options in all
the menus are always available. Their accessibility de-
pends on the current state of the program and the con-
text in which the menu was called up. You'll have to
become familiar with the program before you can re-
liably direct your pointer to the command vou want.
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Figure 13

The Page Setup dialog box, selected from the File menu,
enables you to choose from among a variety of printing
routines.

None of these peculiarities detracts from the pro-
gram's utility. You won't even encounter them unless
vou try to stretch the program to its absolute limits.
But if you do set out to explore Chart's secrets, you
probably will discover a few strange phenomena in the
program'’s outer reaches.

Printing and Filing

Returning to the safe boundaries of Chart's more
common features, vou'll find a series of printing rou-
tines that works without surprises and produces su-
perb results. Selecting Page Setup from Chart's File
menu leads to a dialog box that offers choices for pa-
per format, page orientation, header, footer, and mar-
gins (see Figure 13). By embedding commands in the
header and footer texts, you can center text as well as
insert page, date, and time references. This dialog box
is identical to the one included in Multiplan.

An unusual feature is that the printed chart will
be scaled automatically to fill the specified margins,
regardless of the size of the chart on the Mac screen.
The Imagewriter produces a printed document of fine
quality in high resolution, even though it takes about
12 minutes to print an average chart in standard reso-
lution and up to 3 minutes to print in high resolution.
The first minute of both those times is spent saving the
chart image to a disk file for printing,

Another interesting feature, accessible through
the Edit menu, enables you to copy the image of the
current chart to the Clipboard in either screen size or
printed size. This feature makes it possible to include
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chart pictures in documents from other applications
such as MacWrite, or to copy the image to MacPaint
and then add further graphic enhancements.

The filing commands work the same as in other
Mac applications, enabling you to save the current ver-
sion of the chart or save it under a different name on
any disk.

When opening a file, you have three options:

® You can read in just the data of a file, in which
case it is added as additional series data to the current
chart.

® You can read in the format of a file, in which
case it replaces the current format.

@ |f you read in both the data and the format, the
current fi<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>